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 WARNING 
Read these requirements, installation and operating instructions very carefully. 

Failure to follow the instructions could result in a controller malfunction.  
A malfunction could result in serious equipment damage, property damage, bodily injury or death. 

Install in accordance with the installation manual (provided separately.) 
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GrowControlTM GC-Pro Platform 
 
GrowControlTM GC-Pro is a modular control system designed to be fully customizable to nearly any growing 
control requirements. The core of the system is the GC-Pro controller itself where all of the settings are 
stored and control operations take place. The GC-Pro obtains information about the environment from 
climate sensors, hydroponics sensors, switch sensors and more. The controller uses this information and, 
based on the settings you enter into the controls functions, turns equipment on or off via the controller’s 
“outputs.” The controller and its outputs are low-voltage wet contacts (24Vdc) designed to be connected to 
Agrowtek’s RX/CX relays to switch AC mains power to equipment. Outputs can also be wired to custom 
contactor panels with 24Vdc pilot relays to switch equipment power. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Included 24Vdc power 
supply operates controller, 
sensors and relays. 

~AC Mains Power 

Auxiliary 24Vdc power supply 
can be added if included 
power supply is not sufficient 
for all peripherals. 
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Overview 
 
The GC-Pro cultivation controller is an advanced micro-processor based controller utilizing precision 
electronic climate sensors to offer intricate control of your environment. GrowControlTM is equipped with a 
broad array of flexible features, modes and options to suit nearly any climate controlled environment. 
Settings can be entered easily on the controller screen or with the GrowControlTM PC software.  
 
The GC-Pro is capable of monitoring and controlling up to two different environments (zones) from one 
control unit. 
 
Most controls settings have separate day and night set points which allow you to operate equipment 
differently during these respective periods to obtain optimal crop response.  
 
The PC software can be used to completely control and monitor the controller locally or from afar. Data can be 
logged indefinitely to standard .csv files and live charting displays historical graphical data for up to two days.  
 

Typical Applications 
 
GrowControlTM controllers are designed for the discerning horticulturalist and can be tailored to any use from 
hobby applications to mid and large-sized commercial environments.  
 
GrowControlTM contains many features for use in both greenhouses with sun-light as well as indoor 
environments that do not have the benefit of natural sun light.  
 
Terminology 
 
GrowControlTM takes information from its sensors and clock, and compares the readings with the settings 
entered by the operator. The controller then decides whether to turn equipment (outputs) on or off. 
 
Analog sensors are those that have a variable value such 
as temperature, humidity, etc. 
 
Digital Input sensors are those that act like a switch and 
are either on or off such as a float switch. 
 
Controls Functions are the functions built into the 
controller such as timers, thermostats, humiditats, CO2 
injection, nutrient dosing, etc. 
 
Outputs are what equipment is connected to on the 
controller such as lights, fans, pumps, etc. 
 
Zones are separate environments that are independently monitored and controlled with sensors in each zone. 
 
FlexnologyTM 
 
Multiple controls functions can be assigned to a single output for maximum control flexibility.  
 
For example: a ventilation fan can be controlled by a cooling thermostat and a de-humidify humidistat at the 
same time. A timer could also be setup on the same fan output during the night, for example, to bring in fresh 
air on a time schedule. 

Sensor Inputs 
(temp, humidity, etc.) 

Control Functions 
(thermostats, timers, etc.) 

Outputs 
(fans, heaters, etc.) 

Cooling Thermostat 

Output # 
(ventilation fan, etc.) 

De-Humidify Stat Cycle Timer 
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 AgrowTouchTM Touch Screen 
 
Home Screen 
 
The home screen displays the 
sensor readings, time and date, 
controller run status, and several 
menu buttons. 
 
If the controller is in multi-zone 
mode, the bottom right corner will 
display a button to toggle between 
zone displays. 
 

Screen Saver 
 
The touch screen has a built-in screen 
saver which turns off the back light after 30 
minutes. To re-activate the screen, simply 
touch any where on the screen. 

 
Key Pads 
 
 
 
 
 
 
 
 
 
 

Indoor climate sensor display. Hydroponics sensor display. Outdoor weather sensor display. 

Time & Date 
Press here to activate 
screen saver 

Reading Heading 
Press here to view 
graphing history 

Sensor reading value 

Change display to 
next zone 

Controller Run 
Mode status and 
start/stop menu 

Inputs & Outputs 
Status / controls 

Main Menu 

Change display between 
climate, hydro, weather and 
other sensor displays. 

Graphical meter display 

Decimal Values 
 
There is no decimal point key on the touch screen. For fields that have 
a decimal place, enter the number as follows: 
 
72.5 would be entered as:  7  2  5  Enter 
 
75.0 would be entered as:  7  5  0  Enter 

Acceptable 
range 

Current 
Setting 

Numeric Keypad Alpha-numeric Keypad 

Press the ‘CAP’ key to change 
between upper and lower case, and 
to display special characters. 

Space 

When entering a name, an alpha-numeric  
key-pad will be displayed.  

Enter 

Cancel 

Clear 

Delete / 
Backspace 

When entering a number, a numeric key-pad will 
be displayed.  
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Setting up the Software  
 
The controller can be ordered with or without a touch-screen interface. The PC software can connect to the controller whether 
there is a touch screen or not and can take the place of a touch screen if the controller will never be accessed locally or to 
save cost and use a PC as the sole interface. 
 

Communication Connection 
 
GrowControlTM can be linked to a PC for complete remote control, monitoring, setup and data logging.  
 
The GC-Pro is equipped standard with a RS-232 serial port for local connection to a PC via the PC’s serial port (or a USB port 
with USB converter.) Optionally, the GC-Pro can be equipped with an Ethernet port for connection to your local area network. 
When connected to a LAN, the controller can be accessed via IP address locally or remotely via the internet (with proper port 
forwarding; see Port Forwarding.) 
 
Simultaneous Connections 
When equipped with an Ethernet port, the controller may be accessed simultaneously by multiple PC’s locally or remotely. The 
controller can also connect via its serial port and Ethernet port simultaneously. 
 
Notes: 
1. Serial communication cables can be extended up to 50ft with a male-female extension cable available from Agrowtek. 
2. A USB-to-Serial converter is available from Agrowtek to connect the controller’s serial port to a USB port on your PC. 
3. A “Wireless Bridge” (or a router in bridge mode) can be used to connect the Ethernet port to a wireless router. 
 

Minimum PC Requirements 
 

 Windows® XP, Vista, 7,  8 (32 or 64 bit) 
 Microsoft .Net 4.0 Client Run Time Environment (installer provides download link from Microsoft if not installed) 
 RS-232 DB-9 Serial Com Port, or USB port (with USB-Serial converter) 
 1 GHz processor 
 1 GB Ram 
 6Mb HDD space for program 
 Additional HDD space for data logging files or camera images 

 
 
Installing the Software 
 
Download the installer file from the Agrowtek website:  
 
Http://www.agrowtek.com/download/GrowControlSetup.msi 
 
 
 
 
 
Open the installer and follow the prompts to install the 
program.  

 
 
 
 
 
Running the Software 
 
 

A short-cut to the program should automatically be placed on your desktop and in your start-menu.  
 
Double-click the desktop icon or navigate to “Agrowtek > GrowControl(TM)” in the start-menu to open the 
program. 
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Connecting to the controller 
 
1. Press the “Monitor” button OR from the top menu, select “Connection -> Connect…” 

 
2. The connection dialog appears; select a COM port, or enter the controller’s IP or Remote address. 

TCP Port: If using port forwarding on a port other than the controller’s standard port 502, enter it in the TCP port text 
box. 

3. Press the “Connect” button in the box with the connection you want to use. 

 

1 

1 

Disconnected 

Com Port 
for Serial 

connection 

Connect to 
Com Port 

Connect to 
Ethernet via 
Internet 

Connect to 
Ethernet via 
local network 

Connect to 
Ethernet Port 

Change Ethernet 
IP Settings 
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4. If the controller has an operator password set, you will be prompted to enter your operator (or system) password. 

 
5. The software will perform an initial read of the settings in the controller. 
6. If you connected via the “Connection” menu, you will be asked if you want to start monitoring; press yes to begin 

monitoring the controller or press no to remain connected but not monitoring. 

 
7. The connection indicator in the lower right corner will change to show the connection status. 

 
8. If monitoring, the sensor readings, I/O status and control functions status will be updated. 

 

Disconnected Connected to 
Serial Port 

Connected to 
Ethernet Port 

(Local Network) 

Connected to 
Ethernet Port 

(Remote Address) 

Enter 4-digit pin 
password to 
connect. 
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 Run / Stop 
 
The controller will automatically turn the equipment outputs on and off depending on how they are programmed to operate 
when the system is in “Run” mode. All of the outputs can be stopped simultaneously by placing the controller into “Stop” 
mode. Placing the controller back into “Run” mode by pressing Start will allow the outputs to operate as the controller 
requires. 

 
 
 
 
 
Touch Panel 
 
From the Home screen press the Status button to access the run mode menu. When the controller is stopped, “System OFF” 
will be displayed in red. When the controller is running, “System ON” will be flashing in green. 
 

 
Software 
 
The controller can be started or stopped from the PC software by pressing the “Run/Stop” button in the lower left corner when 
connected to the controller. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.The home screen; press “Stopped” 
button to enter run mode screen. 

2. Press “Run” to place the system into 
‘run’ mode or “Stop” to stop the 
controller. Press “Back” to return to the 
previous screen. 
 

Day/Night/Off 
mode display 

NOTE 
Before any outputs will activate, the system must be placed into “Run” mode. 

When the system is in “Run” mode, the outputs can be turned on. When in “Stop” mode, all outputs will be disabled. 
 

3. The home screen will show green for 
run and the current zone’s day or night 
mode. 
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Inputs & Outputs (I/O) 
 
Outputs 
 
The controller turns equipment on and off by controlling outputs. Each control function (thermostats, timers, etc.) is 
programmed to one of the available outputs as desired. 
 
The controller comes with twelve (12) programmable outputs (GC-Pro-xD is equipped with 20 outputs.) The user names each 
output for reference then assigns control functions to the outputs as required. 
 
Note: “Output Sequence Delay Timer” may delay the activation of any output by the delay time. This prevents multiple 
outputs from activating simultaneously thereby reducing electrical load spikes. 
 
Inputs 
 
Four (4) “Digital” inputs are available to connect switch type sensors (float switches, door switches, leak sensors, smoke 
detectors, etc.) Digital inputs can be programmed to act in a variety of different ways including turning an output device on or 
off when the input it tripped. 
 

Touch Panel 
 
The I/O controls menu displays the current status of all the digital inputs and outputs. An input or output will be green when 
activated, and red when inactive. Touching any of the input or output numbers will display the settings for that input or 
output. 
 

 
Software 
 
The PC software contains the I/O controls on the ‘IO’ tab. If an input or output is activated, it will be shown in green.  
 
Click an input or output button to start, stop or set to automatic mode, change the name or set the interlock/interrupt 
output#. 

Status button indicates run or stopped, 
and day or night (if in run mode.) 

Inputs and outputs that are on are 
shown in green; off are shown in red. 
Pressing an input or output number 
displays the control functions for the 
input or output. 
 

Output can be named for reference, 
manually operated or disabled, and be 
programmed to disable another output 
when on (advanced settings.) 

Inputs 
Outputs 
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Output Settings 
 
Outputs are devices that the controller turn on or off as required (such as lights, fans, pumps, etc.) Each output has its 
operation designated by the controls functions, (described later) but the output can be manually operated or disabled, and can 
utilize an ‘interrupt’ function. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Output Interrupts 
 
The interrupt function causes a selected output number to be disabled any time the parent output is activated. This function 
is most typically used to prevent CO2 outputs from activating when ventilation stages are active.  
 
Interrupt Example: If the output shown above (output #1) is assigned to ventilation fans, and output #2 is assigned to CO2, 
enter “2” in the interrupt value of output 1. (Also see temperature limit functions to cancel CO2 in anticipation of ventilation or 
to prevent combustion generators from operating above a set limit temperature.) 

 
Input Settings 
 
Digital Inputs are those that act like switches (float switches, leak sensors, motion sensors, smoke detectors, etc.)  
Digital inputs can be assigned to perform specific tasks when activated such as activate or disable an output. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Manual over-ride or 
automatic control. 

Output status; green when on, red when off. 
Output name Modify output name 

Output # to cancel when 
the output (#1) is on. Show advanced Show manual over-

ride controls. 

Manual over-ride 
or automatic 
control. 

Input status; green when on, red when off. 
Input 
name Modify input name 

Output # to take 
action on when 
input is true (on.) 

Show advanced settings. Show manual over-
ride controls. 

Select action to take 
when this input is true. 
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Controls Functions 
 
“Controls” are functions such as thermostats, timers, etc. that the controller uses to operate the “outputs” (greenhouse 
equipment.) The grower decides which of the controls functions the controller will use to control the equipment in the 
environment(s.)  
 
Any control function that is used must be assigned to an output or VSC channel #. 
Any control function can be disabled by setting the output number (and VSC channel) to 0. 
 
Multiple controls functions can be assigned to the same output.  
For example; a cooling thermostat and a de-humidistat can both be assigned to an output connected to a ventilation fan in 
order to turn the fan on for either high temperature or high humidity. 
 
Controls functions can be assigned to a zone. 
The controller can monitor up to two sensor zones and the control you set up needs to know if it should respond to the sensor 
readings for zone 1 or zone 2. (A zone number of 0 defaults to zone 1.) 
 

Touch Panel 
 
The controls functions are accessed via the main menu. 
 
 

 

 
 

Software 
 
The controls functions are accessed on the “Controls” tab page when connected to a controller. Click on the controls buttons to 
modify the settings. 
 

 Active controls are highlighted with their respective function color. 
 Clicking on a control button will display the settings for that control function. 

 

Press “Menu” button to enter main 
menu. 

Press “Controls” to enter controls menu. 
 

Controls are broken down into basic 
categories. Press “Next” to access 
additional controls. 
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Lights, Day & Night Mode Controls 
 
The day and night modes controls determine how the controller will decide when to switch between the day and night settings 
that are entered in controls functions. 
 
Day/Night Mode 
 
“Synchronize with Lights” mode synchronizes with the lighting timer; day when lights are on, and night when off.  
 
“Light Irradiance Sensor” mode activates day mode when the light level reaches the “W/m2 Day” set point and activates night 
mode when the light level falls to the “W/m2 Night” set point. This mode is intended to be used in environments with sunlight. 
 
“Flip-Box Mode” is designed to be used with dual zone environments. When in flip-mode the controller will assume zone 1 is in 
day mode when the flip trigger is off and zone 2 is in night mode. When ‘flipped’ zone 1 will be in night mode and zone 2 will 
be in day mode. Use the light flip timer to set the flip time, change delay and trigger outputs. 
 
Day/Night Outputs: Enter an output number to activate during the day or night period. For example, if you want air 
circulation fans to run all day but not at night, enter the fans output number into the “day” output. 
 
W/m2 Day/Night: Light intensity levels which determine day and night when using the light sensor mode, and which will 
activate light alarms (see alarms.) 
 
The day and night modes are accessed via the “Controls” menu.  
System administrator password is required to access the day/night mode menu if set. 
 

 

The day and night mode settings are accessed on the first page 
of the controls menu by pressing the “Light” controls button 
then “Day/Night Mode” button.  

Each zone can detect day/night from the lighting 
timer, light sensor or flip box position. Also, an 
output can be activated during the day or night 
period. 

Activated 
Control 
(highlighted) 
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Lights Timers 
 
The controller has special timer controls for lighting equipment including two 24-hour lighting timers (one for each zone,) each 
with their own secondary ‘B’ bank. The ‘B’ bank can be delayed to activate after the ‘A’ bank for reduced electrical load on 
start-up.  
 
Each lighting stage has its own hot-fire prevention timer which will prevent the lighting outputs from re-activating for a set 
duration once turned off. The hot fire prevention timer ensures lamp bulbs and ballasts will not be damaged due to hot-firing.  
See ‘System Settings’ for hot-fire timer configuration. 

 
Lighting Timer: Enter the time of day (in 24-hour format 0:00-23:59) when the lights should turn on and off. 
 
Output: Enter the output(s) for the primary (A) and secondary (B) lighting banks as connected to the controller. If B is not 
used, leave it assigned to 0. 
 
Delay (B Bank): Delay time (seconds) to start bank ‘B’ after bank ‘A.’ 
 
The lighting menu is accessed from the “Controls” menu under the “Lights” button. 
 

 
Light-Flip Box Control 
 
GrowControlTM is designed to safely and properly switch over lights on a light flip box. For extended light flip box contactor life, 
ballasts should be turned off prior to switching the flip box trigger position. This prevents arcing and burning of the contacts 
and also ensures the ballasts fire the bulbs properly after being switched. 
 
Simply set the time of day to turn the flip trigger on and off and enter a delay time for switching. The delay time (seconds) will 
be applied after turning off the lighting output before changing the state of the flip trigger, and after the trigger has been 
flipped before re-starting the lights. 

 
 

Bank A 
Output 

Bank B 
Output 

On 
Off 

On 
Off 

Lights ‘On’ Time Lights ‘Off’ Time 

Bank B 
Delay 

Hot-fire timer keeps lights Off 

The lights timer settings are accessed on the first page of the 
controls menu by pressing the “Light” controls button then 
“Light Timer” button. 
 

Lights can be operated by a 24-
hour on/off timer. Enter the on 
and off times, and select the 
lights output#. Press “Bank” 
button to show delayed bank B. 

The 24-hour light timer can be 
divided into two banks with a 
on-delay to reduce electrical 
load spikes when the lighting 
timer activates. 

Lights 
Output 

Flip Box 
Output 

On 
Off 

On 
Off 

Flip Box ‘On’ Time Flip Box ‘Off’ Time 

Delay 
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Flip Delay: Seconds to delay before and after switching flip box trigger. 
 
Light Flip Trigger ON/OFF time: Time of day (hh:mm) to turn flip trigger on and off. 
 
Light Output: Output which operates the lighting contactor(s) to turn the ballasts on and off. 
 
Flip Output: Output which operates the light-flip trigger cord. 
 

 
 
Lighting Controls in Software  
 
The day/night mode and lighting controls are located at the top of the controls tab. Click on the controls buttons to modify the 
settings. 

 
 
 
 
 

Light flip settings are found 
in the Light controls menu. 

The light flip timer controls the ballast contactors and 
the flip box for integrated smart control. 
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Temperature Controls 
  
Temperature controls consist of heating and cooling thermostats, and high and low temperature limits (shut-offs.) 
  

Heating & Cooling Thermostats 
 
Cooling Thermostats turn an output on or open VSC’s when the temperature is too hot. Cooling thermostats are used to 
operate ventilation fans, curtains, windows, chillers, evaporative coolers and more.  
 
Heating Thermostats turn an output on or close VSC’s when the temperature is too cool. Use heating thermostats to 
operate heating systems including hvac air handlers, water heaters, floor heating and more. 
 

 
 

Limit Thermostats 
 
Lo-Temp Limits turn an output off or close VSC’s when the temperature is too cool. Low temperature limits can be used to 
close down vents and curtains or stop ventilation fan outputs from operating if the outdoor temperature is too low. 
 
Hi-Temp Limits turn an output off or close VSC’s when the temperature is too hot. High temperature limits can turn off CO2 
combustion generators, light banks, and other equipment if a room is too hot, or to disable heating systems if the outdoor 
temperature is above a minimum.  
 
Limit thermostats take precedence over other commands to an output # or VSC channel.  

 
Staging Thermostats  
 
Thermostats can be staged for multiple levels of heating and cooling. 
 

 
In the example above: 
 
Heat 1 will operate any time the temperature drops below 58 and will continue to heat until 60. 
Heat 2 will operate any time the temperature drops below 50 and will continue to heat until 55. 
 
Cool 1 will operate any time the temperature rises above 75 and will continue to cool until 72. 
Cool 2 will operate any time the temperature rises above 85 and will continue to cool until 80. 
Cool 3 will operate any time the temperature rises above 90 and will continue to cool until 85. 
 

Cooling T-stat #1 
Set Point 75°F 
Dead Band 3°F 

4 5       5 0       5 5       6 0       6 5       7 0       7 5       8 0       8 5       9 0       9 5  

Cooling T-stat #2 
Set Point 85°F 
Dead Band 5°F 

Cooling T-stat #3 
Set Point 90°F 
Dead Band 5°F 

Heating T-stat #1 
Set Point 60°F 
Dead Band 2°F 

Heating T-stat #2 
Set Point 55°F 
Dead Band 5°F 

Temperature 
Reading 

Limit 
Control 

If sensor reading exceeds 
set-points 

Turn OFF output 
If output # is not 0 

Set VSC Position on Channel # 
Both close the VSC 

If channel # is not 0 

Temperature 
Reading 

Thermostat 
Control 

If sensor reading exceeds 
 set-points 

Turn ON output 
If output # is not 0 

Set VSC Position on Channel # 
Cooling Opens, Heating Closes 

If channel # is not 0 
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Thermostat Settings 
 
Each thermostat has specific settings which control its function. 

 
 
Zone#: The zone that the thermostat will take sensor readings from. 
 
Temperature Source: The sensor type from the selected zone (air temperature, water temperature or outdoor temperature.) 
 
Day/Night Set Points: Temperature values for the day and night which will activate the thermostat. 
 
Dead-band: Temperature drop from set-point before turning on heat or turning off cooling (see dead-band below.) 
 
Output#: Enter an output number to turn on (or off if limit control) when the thermostat is active.  
 
VSC#: Enter a VSC channel # to send the target positions to when the thermostat is active. 
 
 

Dead-Band 
 
The “Deadband” setting in determines how tightly a thermostat tries to keep the temperature to the set-point. It is necessary 
to have some dead-band: generally 2.0-5.0°F or 1.0 – 3.0°C. 
 

 
 
 
Touch Panel 
 

 

Set Point 

Output On 
Off 

Dead 
Band 

Cooling 

Set Point 

Output On 
Off 

Dead 
Band 

Heating 

Press “Temp” from the controls menu. Select cooling, heating or high/low limit 
functions. 

Zone # 
(0 defaults to 1) 

Thermostat Control 

Temperature Source 
(Air, Water or Outdoor) 

Set-Points 
Day & Night Values 

Dead Band 
Hysteresis Setting 

VSC Set-Points 
Channel & Position 

(if using VSC) 

Output # 
To turn on/off 

Output # 
Turn On/Off  

VSC Channel 
Send position to channel 

Use standard on/off output, VSC output, 
or both simultaneously when thermostat 
control is activated. 
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Software 
 
The temperature controls are grouped into cooling thermostats, heating thermostats and temperature limits. Click on the 
controls buttons to modify the settings. 

 
 

 
 

Enter the set-points and dead-
band settings. Press “Advanced 
Settings” button to change to 
advanced settings. 

Select temperature zone, sensor 
source and output #. If VSC controls 
are used, enter a channel and position 
settings if desired. 

Select a thermostat to view 
its settings. Active controls 
will be highlighted. 
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Humidity Controls 
  
Humidity controls consist of humidistats and de-humidistats, and high humidity limits. 
 

Humidistats 
 
Humidification Humidistats turn an output on when the humidity is too low. Humidification is used to operate humidifiers. 
 
De-Humidification Humidistats turn an output on or set a VSC open position when the humidity is too high. 
Dehumidification can operate ventilation fans, VSC (vents, shades or curtains) and more to reduce humidity. 

 
Humidity Limits 
 
Hi-Humidity Limits turn an output off when the humidity is too high. Turn evaporative cooler water valves off if the humidity 
is too high. 

 
Control Settings 
 

 
 
Zone#: The zone that the humidistat will take sensor readings from. 
 
Day/Night Set Points: humidity values for the day and night which will activate the humidistat. 
 
Dead-band: Humidity drop from set-point before turning on humidification or turning off de-humidification. 
 
Output#: Enter an output number to turn on (or off if limit control) when the humidistat is active.  
 
VSC#: Enter a VSC channel # to send the target positions to when the humidistat is active. 
 

Dead-Band 
 
The “Dead-band” setting in determines how tightly a humidistat tries to keep the humidity to the set-point. It is necessary to 
have some dead-band: generally 3-10%RH.  

 

Set Point 

Output On 
Off 

Dead 
Band 

Dehumidify 

Set Point 

Output On 
Off 

Dead 
Band 

Humidify 

Humidity 
Reading 

Humidity Limit 
Control 

If sensor reading exceeds 
 set-points 

Turn OFF output 
If output # is not 0 

Set VSC Position on Channel # 
Close VSC 

If channel # is not 0 

Humidity 
Reading 

Humidistat 
Control 

If sensor reading exceeds 
 set-points 

Turn ON output 
If output # is not 0 

Set VSC Position on Channel # 
Open VSC (dehumidify only) 

If channel # is not 0 

Zone # 
(0 defaults to 1) 

Humidistat Control 

Set-Points 
Day & Night Values 

Dead Band 
Hysteresis Setting 

VSC Set-Points 
Channel & Position 

(if using VSC) 

Output # 
To turn on/off 

Output # 
Turn On/Off  

VSC Channel 
Send position to channel 

Use standard on/off output, VSC output, 
or both simultaneously when humidistat 
control is activated. 
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Touch Panel 
 

 

 
Software 
The humidity controls are grouped into humidistats, de-humidistats, and humidity limits. 

 

Select a control modify its settings. 
Active controls will be highlighted. 

Enter the set-points and dead-band settings. 
Press “Advanced Settings” to show advanced.  

Enter a zone#, output# and/or VSC 
channel and position settings. 

Press “Humidity” from the control menu. Select from de-humidify, humidify or 
limit humidistats. 



© 2013 Agrowtek Inc. 
www.agrowtek.com | 83 Ambrogio Dr Suite H Gurnee, IL 60031 | agrowtek@agrowtek.com 

20 

CO2 Injection 
 
CO2 augmentation is controlled via a day-time ppm concentration set-point and the readings from the CO2 sensor. Carbon 
dioxide is not injected during the night time. 
 

 
 
Day ppm: Enter the target CO2 concentration for the day time. 
 
Dead-band: CO2 ppm drop below ppm set-point before re-
activating CO2. 
Example: Set point = 1000ppm, dead-band = 100ppm; Controller 
activates CO2 output at or below 900 and turns off at 1000. 
 
Output#: Enter the output number that the CO2 device being 
controlled is connected to. 
 
See “Interrupts” under “Output Controls” for disabling CO2 output when ventilation output(s) turn on. Also see temperature 
and humidity limit functions to cancel CO2 in anticipation of ventilation or to prevent combustion generators from operating 
above a set limit temperature or humidity. 

 
Touch Panel 
 
The CO2 controls are accessed from the “Controls” menu by touching the “CO2” button. Select between injection and 
ventilation controls. 
 

 

 
CO2 Boost Timer 
 
CO2 Boost Timer allows the standard ppm set-point to be over-ridden by a “boost” (or starvation) set-point for a period of 
time. Simply set the time band in which the over-ride should take place and the desired ppm set-point during that period. 
 
Boost ppm: Enter the target CO2 concentration during the boost timer duration. Note: the boost value may also be lower than 
the standard set-point. When the boost timer period has ended, the CO2 set point will return to the standard set point. 
 

 
CO2 Injection Control 

Turn ON Output  
If output # is not 0 

 

Dead Band 
ppm Output # 

CO2 Set Point 
ppm 

Day Mode 

CO2 Reading 
If sensor reading is low 

Press “CO2” button to access the CO2 
controls. 

Select injection settings. Enter day ppm target, dead-band and 
CO2 output number. Press “boost 
timer” button to modify boost settings. 

Set Point 

Output On 
Off 

Dead 
Band 

CO2 Injection 
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Touch Panel 
The CO2 boost controls are accessed from the CO2 injection controls settings by pressing the “boost timer” button. 
 

 
 
 

CO2 Ventilation 
 
CO2 can be reduced by activating an output (such as a ventilation fan) and/or setting a VSC to open. 
 

 
 
 
Day/Night ppm: Enter the maximum CO2 concentration for the day/night which will activate the ventilation control. 
 
Dead-band: CO2 ppm drop below ppm set-point before de-activating the control. Example: Set point = 2500ppm, dead-band 
= 1000ppm; Controller activates ventilation output(s) at or above 2500ppm and turns off at 1500ppm. 
 
Output#: Enter the output number that the CO2 device being controlled is connected to. 
 
VSC# VSC Channel to send minimum open command to. 
 
% Open Minimum desired VSC open position day or night when CO2 level exceeds set-points. 
 

 
CO2 Vent Control 

Dead Band 
ppm 

CO2 Set Point 
Day/Night Max ppm 

Day/Night 
Mode 

CO2 Reading 

If sensor reading is high 

VSC Set-Points 
Channel & Position 

(if using VSC) 

Output # 
To turn on/off 

Output # 
Turn On  

VSC Channel 
Send position to channel 

Use standard on/off output, VSC 
output, or both simultaneously when 
CO2 vent control is activated. 

Access the CO2 injection settings from 
the controls menu. 

Press the “boost timer” button to 
access the boost over-ride settings. 

Enter start and end time of over-ride 
period and the ppm value. 

Set Point 

Output On 
Off 

Dead 
Band 

CO2 Ventilation 
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Touch Panel 
 
The CO2 controls are accessed from the “Controls” menu by touching the “CO2” button. Select between injection and 
ventilation controls. 
 

 
Software 
 
The CO2 ventilation controls are accessed from the “CO2” controls group on the “Controls” tab. 
 

 
 

Control set points and on/off 
output selection. 

VSC % output settings. 

Only settings applicable to injection 
are shown. Over-ride standard CO2 set-point 

during the time interval. 

Press “CO2” button to access the CO2 
controls. 

Select ventilation settings. Enter maximum ppm values, dead-
band, on/off output and/or VSC # and 
minimum % open settings for VSC. 
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Timer Controls 
 
The GC-Pro is equipped with an array of different timers which can control all types of equipment including fans, pumps, 
irrigation equipment, lights, and much more. 
 
24 Hour Timers operate like a standard wall timer with an on and off time of day. 
 
Cycle Timers operate in a repeating on/off cycle. 
 
24 Hour Cycle Timers are cycle timers that only operate within a specified 24-hour on/off time slot. 
 
Delayed Off Timers continue to operate an output for a delay after it (or another output) has been turned off. 
 
Band Timers allow an output to operate only within a specified 24-hour on/off time slot. 
 
Re-Start Delay Timers disable an output for a delay time after the output has shut off. 
 
 

Touch Panel 
 
The timers are accessed from the control menu. 
 

 Software 
 
The timer settings are accessed via the controls tab under the timers groups. 

 

Press “Timers” button to access the 
timers sub-menu. 

Select a timer type to view and modify 
the available timer controls. 
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24-Hour Timers 
 
24-Hour timers operate like a standard wall timer and can activate an output or set a VSC control to a % open target. 
 

 
On Time: Time of day to turn on timer control. 
 
Off Time: Time of day to turn off timer control. 
 
VSC #: VSC control to send minimum % open value to when timer control is on. 
 
Note: 24 hour timers operate in 24-hour time format: 0:00 – 23:59. 
 

Touch Panel 
 
The 24-hour timer menu is accessed from the timers menu. 
 

 
Software 
 
The 24-hour timer settings are accessed via the controls tab under the “24-Hour Timers” group. 
 

Time of Day 
0:00 – 23:59 

Timer Control If time is between on and off 
time 

Turn ON output 
If output # is not 0 

Set VSC Position on Channel # 
Open VSC 

If channel # is not 0 

On & Off Time 
0:00 – 23:59 Output # 

VSC Channel  
& Position 

Use standard on/off output, VSC output, 
or both simultaneously when timer 
control is activated. 

Press “24 Hr Timers” button 
to access the 24 hour timers. 

Select a timer to view settings. Enter the on & off times and 
output number to activate (if 
desired.) Press ‘output’ button to 
toggle to VSC output settings. 

Enter a VSC control address 
and minimum % open target (if 
desired.) 
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24-Hour Cancel Timers 
 
24-hour cancel timers operate like a 24-hour timer, except instead of turning an output on, they will allow it to operate only 
during a specified time band, and disable it outside of the allowed time band. 
 

 
Example uses include: 

 Disabling equipment prior to ‘lights out’ or ‘lights on’ times. 
 Operating CO2 output(s) only during a preferred period. 

 
Start Time: The time of day that the output becomes disabled. 
 
End Time: The time of day that the output is allowed to be activated again. 
 
Output: The output which will be canceled when cancel timer is active. 
 
VSC #: VSC control to limit to maximum % open value when cancel timer is active. 
 

Touch Panel 
The 24-hour cancel timer menu is accessed from the timers menu. 
 

 
Software 
The 24-hour cancel timer settings are accessed via the controls tab under the “24-Hour Cancel Timers” group. 
 

 

Time of Day 
0:00 – 23:59 

Timer Control If time is between start and 
end time 

Turn OFF output 
If output # is not 0 

Set VSC Position on Channel # 
Close VSC 

If channel # is not 0 

Start & End Time 
0:00 – 23:59 Output # 

VSC Channel  
& Position 

Use standard on/off output, VSC output, 
or both simultaneously when timer 
control is activated. 

Press “24 Hr Timers” button 
to access the 24 hour timers. 

Select a timer to view settings. Enter the start and end times 
and output number to disable (if 
desired.) Press ‘output’ button to 
toggle to VSC settings. 

Enter a VSC control address 
and maximum % open target 
(if desired.) 
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Cycle Timers 
 
Cycle timers operate in a continuously repeating on-off-on… loop. Cycle timers can be operated during the day & night, day 
only, or night only. 
 

 
 
On/Off Time: Specify the on and off durations for the cycles. 
 
Timer Units: Select units of minutes or seconds. 
 
When to Operate Timer: Choose when this timer should 
operate; day only, night only or both. 
 
Zone: Zone to detect day and night from. 
 
Output: Output to operate with the cycle timer. 
 
Example uses include: 

 Timing water pumps for hydroponics systems. 
 Intermittent operation of circulation fans or ventilation fans 
 Other timed, cycled equipment. 
 

Touch Panel 
The cycle timer menu is accessed from the timers menu. 
 

 
Software 
The cycle timer settings are accessed via the controls tab under the “Cycle Timers” group. 
 

Output On 
Off 

‘On’ Time ‘Off’ Time 

Day/Night 
Start 

Day/Night 
per zone# 

Timer Control If Day/Night status = Mode 
(and On/Off times are not 0) 

Turn ON Output 
for ON time duration 

On & Off Time 
Mins / Secs Output # 

Time Units 
Mins/Secs 

Mode 
Day/Night/Both 

Zone # 
0 defaults to 1 

Turn OFF Output 
for Off time duration 

Press “Cycle Timers” button to access 
the cycle timers menu. 

Select a timer to view its settings. Press the buttons to change the values 
with a numeric key pad. 
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24-Hour Cycle Timers 
 
24-hour cycle timers are cycle timers which operate only within a specified time of day. (See cycle timers.) 
 

 
Time Band: Specify the time daily time band that the output should 
be allowed to operate in. 
 
On/Off Time: Specify the on and off durations for the cycle timer. 
 
Timer Units: Select units of minutes or seconds for the cycle timer. 
 
Output #: Output to operate with the cycle timer. 
 
 

Touch Panel 
 
The cycle timer menu is accessed from the timers menu. 
 

 
Software 
 
The 24-hour cycle timer settings are accessed via the controls tab under the “24-Hour Cycle Timers” group. 
 

 

Time of Day 
0:00 – 23:59 

Timer Control If time of day is within  
24-hour time band 

Turn ON Output 
for ON time duration 

Cycle Times 
On & Off Durations Output # 

Cycle Timer Units 
Minutes/Seconds 

24-Hour Time Band 
On & Off Time of Day 

Turn OFF Output 
for Off time duration 

Press “24/Cycle Timers” button to access 
the 24-hour cycle timers menu. 

Select a timer to view its settings. Press the buttons to change the values 
with a numeric key pad. 

Output On 
Off 

‘On’ Time ‘Off’ Time 

“Time Band” 
Time of Day 
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Off-Delay Timers 
 
Off-Delay timers operate an output when the “trigger output” is activated and continue to operate the “Off Delay” time after 
the trigger has turned off.  
 

 
Trigger Output: Enter the output that should trigger the activation of 
the off-delay timer output. 
 
Delay Time: Time (seconds) that the off-delay timer output should 
remain on after the trigger output turns off. 
 
Output: Output to turn on when the trigger activates and remain on 
for the delay time when the trigger turns off. 
 
Example uses include: 

 Operating a heater fan so that it is synchronized with the heater’s thermostat but remains on after the thermostat 
has turned off to cool down the plenum and duct work. 

 Operating a return tank [or similar] pump that must remain on a set time longer than a main feed pump. 
 Prevent a fill valve or pump from short cycling due to a ‘bouncing’ float switch. 

 
Note: The trigger and timer outputs can be set to the same output. 
 

Touch Panel 
The off-delay timer menu is accessed from the timers menu. 
 

 
Software 
The off-delay timer settings are accessed via the controls tab under the “Off-Delay Timers” group. 
 

 

Timer Control 

If Trigger Output is activated Turn ON Output 

Trigger Output # 
Output to Activate Timer Output # 

Off- Delay Time 
Seconds 

Keep Output ON 
for Off-Delay Time 

Trigger Status 
On or Off If Trigger Output turns Off 

Press “Off Delay Timers” button to 
access the off-delay timers menu. 

Select a timer to view its settings. Press the buttons to change the values 
with a numeric key pad. 

Trigger On 
Off 

Output On 
Off 

Off-Delay 
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Re-Start Delay Timers 
 
Re-start delay timers sense when an output has just turned off, then disables the output for the re-start delay time. This timer 
is designed to prevent short-cycling of equipment. 
 

 
Delay Time: The amount of time that the output will be disabled for once it has 
turned off. 
 
Output: The output which is being managed by this timer. 
 
Example uses include: 

 Prevent a compressor motor from short-cycling. 
 Prevent a heating system from short-cycling. 

 

Touch Panel 
 
The band timer menu is accessed from the timers menu. 
 

 
Software 
 
The re-start delay settings are accessed via the controls tab under the “Re-Start Timers” group. 
 

Timer Control 

Output # Re-Start Delay Time 
Seconds 

Keep Output OFF 
for Re-Start Delay Time 

Output Status 
On or Off If Output turns Off 

Press “Re-Start Timers” button to access 
the re-start delay timers menu. 

Select a timer to view its settings. Press the buttons to change the values 
with a numeric key pad. 

Output On 
Off 

Re-Start Delay 
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VSC Vent, Shade & Curtain Controls 
 
GC-Pro has four (4) VSC controls which can control roof vents, side wall curtains, sun shades and more. VSC controls manage 
a vent, shade or curtain from 0-100% open. The default position is closed (0% open) and VSC controls are told to open by 
thermostats, humidistats, timers and more- any control with a VSC output option. 
 

 
 
How VSC Works: 
 

1) Controls functions such as a thermostat, humidistat or timer are addressed to the VSC channel of choice. 
2) A VSC control is set up including: the open and close outputs to operate the motor(s) and the total travel time for the 

vent, shade or curtain to move from fully closed to fully open (advanced settings.) 
3) The channel for the VSC to receive commands must be entered into the VSC control. Multiple VSC controls may be on 

the same channel to open and close to the same positions. 
4) The VSC control is placed into “Auto” mode. 
5) The VSC control will open to the maximum position called for by the controls functions unless a limit control or 

manual maximum setting sets the VSC to a reduced position. 
 
Note: “Limit controls” and “24-hour cancel timers” will set a maximum open position for a VSC control (instead of target 
minimum open position.) 
 

VSC Settings 

 
 
Zone#: The zone that the VSC is operating in. 
 
VSC Channel: The channel that the VSC control will take position commands from. Multiple VSC controls can be on the same 
channel and will open and close to the same target positions (assuming the VSC controls have the same limit and over-ride 
settings.) 
 
Min/Max Open: The limits that the VSC should operate within. Typical values are minimum = 0 and maximum = 100%. The 
min/max position can be used to manually operate the vent or curtain, or set different limits of each vent/curtain while 
maintaining the same target from a single channel. 
 
Travel Time: The time (seconds) to operate the vent, shade or curtain from fully closed to fully open. 
 
Open/Close Output #’s: The outputs which drive the open and close inputs on the motor controller. 
 

 
 

VSC Control 

VSC 
Channel # 

Min/Max 
Open % 

Open Output # 

Zone # 

Rain Sensor 
Rain Detected 

Close Output # 

Rain  
Max 

Open % 

Wind Sensors 
Speed Exceeded 

Vent Azimuth 
Max Wind Speed 
Wind Max Open 

Travel 
Time 

Open/Close 
Output #’s 

Change 
Delay 
Time 

VSC Channel 
Target Position % 

Auto Mode 
Enable/Disable Enable Auto Control 

Set VSC Position 
(if no overrides are set) 

Link 
Output#/ 
Max Open 

Link Output 
Output Activated 

Set Rain Position 

Set Wind Position 

Set Link Position 

Overrides: 

Safety Delay Timer 

VSC Channels 

Control Functions 
Thermostats, Humidistats, Timers, etc. with VSC settings 

VSC Control 1  

Open 
Output 

Close 
Output 

VSC Control 2 

Open 
Output 

Close 
Output 

VSC Control 3  

Open 
Output 

Close 
Output 

VSC Control 4  

Open 
Output 

Close 
Output 
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Azimuth: The windward direction of the vent as viewed from inside the structure. The controller will automatically calculate a 
180° range from this direction (90° each way) in which if the maximum wind speed is detected, the vents will activate the 
wind speed override. If no wind direction sensor is present, the system defaults to speed only. 
 
Max Wind Speed: If the wind speed is exceeded the VSC control will activate the wind speed override and set the wind 
position as the maximum allowed position. The override will be released when the wind speed drops below the limit. 
(Recommended to set the Change Delay Time to prevent short cycling.) 
 
Wind Max Open: Maximum allowed open position during wind speed override. 
 
Rain Max Open: Maximum allowed open position during rain override. 
 
Link Output / Max Open Position: When a selected output is activated (link output #) the VSC control will set the 
maximum allowed open position to the Link Position. This is typically used to close a vent or curtain down to a minimum 
position when a ventilation fan is active in order to draw air in evenly through the vent or wall rather than through the area 
nearest the ventilation fan(s.) 
 
Change Delay Time: After the VSC completes a move and turns off the Open or Close output, the change delay timer will 
disable automatic operation of the Open or Close outputs for a set duration. This prevents short cycling of vents and keeps 
vents closed down for a minimum period after weather overrides have been set. 
 
Safety Delay Time: This timer compensates for any time-delays in motor controllers. If the motor controller has a time delay 
between when the GrowControlTM controller activates the open/close output and when the motor controller actually starts the 
motor, enter this time value here. 
 

Manual Operation 
 
VSC controls can be manually operated in two ways; by adjusting the maximum and minimum positions, or by disabling the 
automatic control and manually turning the open or close output on until the desired position is reached. The controller will 
continue the position. 
 

 To manually open a vent or curtain (while still allowing the system to open further automatically in Auto mode) 
simply set the “minimum open position” to the desired position. To Close and override the automatic control of the 
vent or curtain, set the “maximum open position” to 0. 

 When auto mode is off the controller will continue to track the VSC position even if manually operated via the 
controller’s manual over-rides. When auto mode is turned back on, the vent will attempt to return to the target 
position.  

 
Note: The GrowControlTM controller can not track position changes if operated manually by the motor controller. 
 
Calibration 
 
If the motor controller has been operated manually, the position will most likely need to re-calibrated. Simply close the vent or 
curtain fully and set the position to 0.  
 

Touch Panel 
The VSC control settings are accessed from the first page of the controls menu. 
 

 

Press “VSC % Controls” button to access 
the VSC controls. 

Current VSC positions are shown. 
Select a VSC control to view/modify 
settings or position. 

VSC control can be set to auto or off and 
displays target position from the selected 
channel and actual position. The position 
settings can be viewed and modified here. 
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Software 
The VSC controls can be monitored and adjusted in the “VSC” group on the “Controls” tab. 

 

VSC Settings 
VSC Actual Positions 

Press “Advanced Settings” button to 
access the advanced VSC settings. 

Enter settings as required. Press 
“calibration” to set the VSC position 
and modify the safety delay timer. 

Calibration and Safety Delay timers are 
shown for VSC controls 1-4. Enter the 
actual position or “0” to set home 
(closed) position. Safety delay time 
setting is below the calibration setting.  
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Nutrient Dosing 
 
GrowControlTM can monitor your nutrient levels and dose up to an 8-part nutrient solution to 
maintain automatic control of your nutrient concentration. The GC-Pro is designed to deliver 
precision volumetric doses with Agrowtek’s standard AgrowDoseTM nutrient pumps.  
 
AgrowDoseTM pumps are durable peristaltic pumps which deliver consistent doses from any size 
stock tank to your reservoir for reliable, low maintenance dosing. Solenoid valves and other 
equipment can also be used on a timed basis. 
 

Automatic & Batch Nutrient Dosing 
 

 
Batch Dosing 
 
Batch dosing automatically calculates and injects the proper volume of nutrients for a given batch or reservoir size. Setup the 
nutrient parts according to the manufacturer’s mL/Gallon concentrations (see advanced settings.) Enter the batch volume in 
U.S. gallons. If desired, setup drain and fill outputs and times to automatically drain and re-fill the reservoir prior to dosing the 
batch. 
 
Batch dosing will automatically dose all parts that have a ratio (mL/Gal) and a pump output assigned when a batch is 
manually started, or when the scheduler shifts to new settings at a specified date and time. 

 
Batch/Reservoir Size: Total gallons of water in the reservoir. The batch dosing control will multiply the nutrient part ratios 
(mL/Gal) by the total amount of water to determine the total amount of each nutrient to add. 
 
Drain/Fill Output #: The outputs which operate drain/fill pumps or valves for automatic water changes. 
 

 
Batch Nutrient Dose Control 

Calculate Length of Time to run each Dosing Pump 

Batch/Reservoir Size 
Total Gallons 

Start Batch 
Manually 

Scheduled 
Batch 

Pump Flow Rate 
(system units) 

Separation Delay Timer 

Dose each part until all parts with values have been dosed. 

Drain/Fill  
Output #’s 

Drain/Fill  
Times (mins) 

Enable Auto 
Fill/Drain 

Part Delay 
Seconds 

Cancel 
Output # 

Auto Change 
Drain & Fill Reservoir 

Start 
Batch 
Cycle 

If Cycle 
is Active 

Disable Output 
(feed pump, etc.) 

Parts 1 - 8 
mL/Gal 

Dose Pump 
Output # Run Dose Pump Output 

Automatic & Batch Dosing Batch Dosing Only Monitoring Only 

+ + + + 

Controller and sensors allows 
monitoring of hydroponics 
systems. 

Without hydroponics sensors, 
GrowControlTM can automatically 
change and dose nutrient batches 
on a 16-week schedule or 
manually on demand.  
(pH adjustment required.) 

A controller with sensors and dosing pumps 
allows both dosing option to be used. 
Schedule reservoir changes and perform 
batch-dosing, as well as maintain ideal 
nutrient concentration and pH automatically. 
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Drain/Fill Time: Minutes to drain and fill the reservoir respectively. 
 
Cancel Output #: Output to cancel when batch dosing is active. Use this to prevent feed pumps from operating when dosing. 
Set to disable the cancel output when dosing is active in batch mode only, or either batch mode or auto mode.  
 
 

Touch Panel 
The nutrient dosing settings are accessed from the controls menu. 
 

 
Software 
 

Press “Nutrient Dosing” button to access 
the nutrient dosing menu. 

Enter a batch/reservoir size (gallons.) 
Enable/Disable batch dosing. Press 
“1” to toggle zone 1 to zone 2. 

Press “Auto Dosing” button to access the 
automatic nutrient dosing menu. 

Setup drain & fill (optional) and 
manually start a batch. 

Enable/Disable automatic reservoir 
changes, set drain & fill times and 
output numbers. 

Initiate a batch cycle and monitor 
which pump is active and the total 
amount it will dose. 
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Automatic (Demand Based) Dosing 
 
If your GrowControl system is equipped with hydroponics sensors, (pH, conductivity and water temperature) the controller can 
maintain the nutrient concentration automatically. The automatic nutrient dosing works like many other commercial dosing 
systems available today and is a very simple, reliable process. 
 
The controller monitors the conductivity, or concentration, of the nutrient solution. When the concentration is below the set 
points, the dosing process will be initiated. Each pump will deliver the dose in milliliters as set in each part. The process will 
then repeat with the dwell time between each cycle until the nutrient level reaches the set-point. 

 
Day/Night EC (or TDS): The desired conductivity (or TDS) for the controller to maintain during the day and night periods. 
Note: to disable dosing during day or night set the value to 0. 
 
Deadband: The EC (or ppm) drop to allow before starting a dosing cycle (see below.) 
 
Cancel Output #: Output to cancel when batch dosing is active. Use this to prevent feed pumps from operating when dosing. 
Set to disable the cancel output when dosing is active in batch mode only, or either batch mode or auto mode.  
 
Notes:  

1. The cycle dwell time can be set to 0 for continuous dosing cycles. 
2. The part delay time can be set to 0. 
3. The dose parts can be multiplied by a factor to achieve larger doses per cycle and the reservoir/batch size divided by 

the same factor to batch dose proper amounts. 

 
Dead-Band 
 
The “Dead-band” determines how much of a nutrient drop is allowed 
before re-dosing back up to the set point. 
 
Example: Controller doses up to 1000ppm; dead-band = 100ppm. 
When ppm falls below 900, controller will dose back up to 1000.

Start Dose Cycle 
If Nutrient Concentration is Low 

 
Auto Nutrient Dose Control If Dosing 

is Active 

Disable Output 
(feed pump, etc.) 

Calculate Length of Time to run each Dosing Pump 
Injects amounts for a single gallon of water each cycle. 

Separation Delay Timer 

Run Dose Pump Output 

Enable  
Auto Dosing 

Part Delay 
Seconds 

Dose Pump 
Output # 

Pump Flow Rate 
(system units) 

Conductivity 
Reading 

Cancel 
Output # 

Set-Points 
Day & Night Values 

Parts 1 - 8 
mL/Gal 

Dead Band 
Hysteresis Setting 

Cancel in 
“Auto & Batch” 

Mode  
Enabled 

Delay After 
Parts Mode 

ALL 

1 & 2 
Only Part # Delay 

After 

1 or 2 

Auto Dose Mode 
All or Parts 1 & 2 only 

Cycle Dwell Timer 

Else Last 
Part 

Cycle Dwell 
Seconds 

Set Point 

Dosing On 
Off 

Dead 
Band 

Nutrient Concentration 

Dosing Cycles 
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Touch Panel 
The auto dosing controls are located in the main controls menu. 
 

Software 
The nutrient dosing settings are accessed via the controls tab under the “Nutrient Dosing” group. If the controller is in multi-
zone mode, there will be two dosing groups; 1 & 2. 
 

 
Dosing Parts / Pumps 
 
The GC-Pro can operate up to eight (8) dosing pumps each with their own dose volume (or time.) 
 
Part 1-8: (mL/Gal or seconds) In ‘batch’ mode, the part ratio (mL/Gal) is multiplied by the total batch size to find the total 
dose amount for each part. In ‘auto’ mode the controller will add this amount (for one gallon) of each part in repeating cycles 
until the concentration set point has been met.  
 
Output Pump 1-8: The output numbers to assign to the respective dosing pumps. 
 

Touch Panel 
The dosing pumps and part ratios are found under the nutrient dosing main menu. 
 

Press “Parts” button to access the 
nutrient part ratios and pump outputs. 

Press “1” to toggle zone 1 to zone 2 
(multi-zone mode only.) 

Set nutrient part ratios and pump output 
assignments. 

Press “Nutrient Dosing” button to access 
the nutrient dosing menu. 

Press the number values to enter or 
adjust with the numeric key pad. 
Press “1” to toggle zone 1 to zone 2 
(multi-zone mode only.) 

Press “Auto Dosing” button to access the 
automatic nutrient dosing menu. 



© 2013 Agrowtek Inc. 
www.agrowtek.com | 83 Ambrogio Dr Suite H Gurnee, IL 60031 | agrowtek@agrowtek.com 

37 

Software 
 
The dosing pump outputs and ratios are each displayed separately and indicate which stage of dosing is active. 
 

 
 
Advanced Nutrient Dosing Settings 
 
Auto Dose Mode: (ALL or 1 & 2) Select whether all nutrient parts are auto-dosed on demand, or only parts 1 & 2. 
 
Delay After Mode: Select whether the controller will apply the “part delay” time after all parts, or only 1 & 2. 
 
Part Delay Time: (seconds) Time to wait between dosing each part. 
 
Cancel Mode: (Auto Only or Auto & Batch) Disable the “cancel output” when batch dosing only, or when batch dosing and 
automatic dosing. 
 
Cancel Output #: Output number to turn off when dosing is active (i.e. feed pump output.) 
 
Cycle Dwell Time: The time to wait before dosing when nutrient level goes low and between each subsequent dosing cycle. 
 
Scheduler: Enable or Disable automatic updates from nutrient scheduler (see scheduler.) 
 

Touch Panel 
 
The advanced nutrient dosing settings are accessed from the ‘auto’ or ‘batch’ dosing menu. 
 

 

Access the “Advanced” settings from the auto or batch dosing menus. Set auto dose mode, part delay mode, 
cancel mode, enable/disable scheduler, set 
auto cycle dwell time, part separation 
delay time and cancel output#. 



© 2013 Agrowtek Inc. 
www.agrowtek.com | 83 Ambrogio Dr Suite H Gurnee, IL 60031 | agrowtek@agrowtek.com 

38 

16-Step Nutrient Scheduler 
 
GrowControl The scheduler can update the concentration set points and nutrient part ratios at the time and date which is set 
for each of the available 16 steps. Batch dosing can be automatically initiated on the change to drain and fill the reservoir, 
then dose with the required nutrient amounts.  
 
To setup the scheduler:  

1. Starting at step #1, enter a date and time when the change will occur. 
2. Set the desired concentration levels (if using auto dosing.) 
3. Set the nutrient part ratios (mL/Gal) for each part to be dosed. 
4. Repeat steps 1 through 3 for each of the steps/dates in the growth process. 
5. Enable the dosing scheduler. 

 

Touch Panel 
 
The scheduler is accessed via the nutrient dosing menu. 
 

 
Software 
 

 

Access the nutrient scheduler 
settings. 

Set mL/Gal values. Use “Next/Prev” 
buttons to move through the 
scheduler steps. 

Adjust the concentration set points and 
effective date/time. Press the “Part” 
buttons to access mL/Gal ratios. 
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pH Dosing 
 
GC-Pro can monitor your pH levels and dose up and down buffer solutions to maintain automatic control of your nutrient pH.  
 
The GC-Pro is designed to deliver volumetric doses with Agrowtek’s standard AgrowDoseTM pumps. AgrowDoseTM pumps are 
durable peristaltic type pumps which deliver consistent doses from any size stock tank to your reservoir for reliable, low 
maintenance dosing. Solenoid valves and other equipment can also be used on a timed basis if desired. 
 
pH  dosing works like nutrient dosing and is a very simple process. The controller monitors the pH reading and when it is 
outside of your pH settings, it will initiate the dosing process either up or down as required. The dosing process starts with a 
delay time; if the pH returns to within parameters before the delay time has elapsed, the dosing process will be terminated. If 
the pH still needs correction after the delay time, the required pump will deliver the set milliliter dose. The process will then 
repeat with the delay time between each dose until the pH reaches the set-point. 
 

 
 
Day/Night pH Set Points: The desired pH for the controller to maintain during the day and night periods. 
 
UP Dose: mL (or seconds) The dose amount that the UP dosing pump should deliver on each up-dosing cycle. 
 
DOWN Dose: mL (or seconds) The dose amount that the DOWN dosing pump should deliver on each down-dosing cycle. 
 
UP / DOWN Output #’s: The output numbers to assign to the respective up and down dosing pumps. 
 
Dwell Time: The time to wait before dosing when pH needs correction and between each subsequent dosing cycle. 
Note: The dwell time can be set to ‘0’ for continuous repeating dosing cycles. 
 
Nutrient Dosing Interrupt 
pH is often influenced by nutrient dosing and it may be desirable to have the system wait until the nutrient dosing is complete 
before dosing pH; if this is the case, set the nutrient dosing interrupt to “On.” Otherwise, to allow pH dosing to occur 
simultaneously with nutrient dosing, set the dosing interrupt to “Off.” 
 
Cancel Output: Output to disable when pH dosing is active. Intended to disable the main feed pump when dosing if desired. 
To disable this feature, leave the cancel output set to 0. 
 
Dead Band: Drift allowed from set point before re-dosing back to set point. 
 
Reverse Band: Drift allowed in opposite direction before dosing opposite pump back to set point. 
 

If pH outside set range 
Start Dose Cycle 

 
Auto pH Dose Control If Dosing 

is Active 

Disable Output 
(feed pump, etc.) 

Calculate Length of Time to run Dosing Pump 
Injects dose amount (mL) each cycle. 

Wait Dwell Time 

Enable  
pH Dosing 

Dwell Time 
Seconds 

Pump Flow Rate 
(system units) 

pH 
Reading 

Cancel 
Output # 

Set-Points 
Day & Night Values 

Dead Band / 
Reverse Band 

pH UP Dose 
mL per cycle 

pH DOWN Dose 
mL per cycle 

UP/DOWN Pump 
Output #’s 

Run Dose Pump Output 

If dosing still required 

If interrupt enabled & nutrients dosing, 
wait until nutrient dosing is complete. 

Nutrient Dosing 
Interrupt 
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Dead-band Settings 
 
The pH control can dose in both directions; pH up and pH down. When the controller is called to dose pH, it will inject doses as 
specified until it reaches the set point. If the pH drifts back again by the dead band amount, dosing will resume until it reaches 
the set point. If, for some reason, pH goes the opposite direction, the system will allow a drift of the reverse dead band before 
dosing the opposite direction. A higher reverse dead band will help prevent over-dosing from over-shooting if necessary. 
 
For example: Set point =6.00, dead band = 0.1, reverse band = 0.3. The tank starts at pH 8 and is dosed down to pH 6. If pH 
rises above 6.1 the system will re-dose down to 6. If the pH had fallen below 5.7 it would dose up to 6.0. Once it has dosed in 
the up direction, it will dose back up if pH falls below 5.9 or dose down if pH rises above 6.3. The dead band and reverse band 
may be set to the same value. 

 
 

Touch Panel 
 
The pH dosing settings are accessed from the controls menu. 
 

 
Software 
 
The pH dosing settings are accessed via the controls tab under the “pH Dosing” group.  

 

Touch “pH Dosing” to view 
the pH dose controls. 

Enter day/night set points. 
Select pumps or advanced to 
modify additional settings. 

Set dosing pump outputs and 
size of dose (ml) per dosing 
injection cycle. 

Dead-band, reverse-band, 
disable output #, dwell delay 
time and interrupt  mode are 
set in advanced. 

Set Point 

Dose 
Up 

On 
Off 

Reverse Band 

Dose 
Down 

On 
Off 

Dead Band 

Up/Down 
Direction Change pH 

Dose Size per Cycle 

Dwell 
Time 

Dosing 
Cycle 

Dosing 
Called 

Dosing 
Complete 
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Alarms 
 
The GC-Pro has built-in high and low set-point alarms for all of the sensor readings. Alarms are displayed and logged in the 
AgrowTouchTM panel and are sent in an email alert by the GrowControlTM software. 
 
Each alarm has a trigger point and a toggle to enable or disable the alarm.  
 
High Air-Temperature Alarm will automatically disable the lighting output for the respective zone. 
 
 

Touch Panel 
 
The alarms settings are accessed under the “Data” menu from the Main menu. 
 

 
Software 
 
The alarms settings are accessed via the “Alarms” tab. The software has several additional alarms for notification in the event 
that a sensor is disconnected and if a digital input has been activated. 
 

 
 
Software Alarms 
 
The software has several additional alarms which can send an email or sms. Simply check “Enable” to activate the alarm. 
 
Analog Sensor Failure: If one of the analog sensors (such as climate sensor or hydroponics transmitter) become 
disconnected, the software will send an email alert. 
 
Note: In the event one of the analog sensors becomes disconnected, the controls functions associated with that sensor will be 
disabled. 
 
Digital Input Alarms: Activates when the respective digital input (such as a door switch, leak sensor, etc.) is activated. 
 

Press “Alarms Settings” button to access 
the alarms settings menu. 

Select an alarm class to view its alarms 
settings. 

Note: If the alarm has a set point, enter 
it before enabling the alarm. 
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Alarms Email/SMS Text Alerts 
 
The software is capable of sending an email or SMS alert in the event an alarm is triggered. The alert will include the details of 
the alarm including the current sensor reading, time stamp and the zone that it was triggered from. Alerts are sent using an 
email address (such as gmail) to send alerts to the same email address, or to SMS. 
 
To send alerts: 

 The computer must be connected to the Internet. 
 The GrowControl software must be connected and monitoring the controller(s.) 
 The sending email account settings must be configured and a test-email successfully delivered. 
 The alarms settings must be configured. 

 
 

Email Settings: 
 
Email Address: Enter the email address of the account you will be using to send and receive emails. 
Ex: “youremail@gmail.com” 
 
Password: Enter the password for the email account. (It will not be displayed.) 
 
SMTP Server: Enter the SMTP server address that your email server uses. See your email provider for this information. 
Ex: smtp.gmail.com 
 
Port: Enter the port number that your email server uses. See your email provider for this information. 
Ex: “587” is used for gmail. 
 
Enable SSL Security: Check whether your email server uses SSL encryption. 

 
Sending a Test Email 
 
Once you have entered the email settings as described above, press 
“Send Test Mail” to test the settings. 
 
If the email was sent successfully, the “Enable Email Alerts” check box 
will become clickable. Check the check box to allow the software to 
send alerts when alarms are triggered. 
 
 

SMS Settings 
 
Once a test email has been sent and alerts are 
enabled, they can be sent to a wireless phone 
number as well as email. 
 
Enter your complete 10-digit phone number and 
select your mobile wireless carrier from the drop-
down list. 
 
If you carrier is not listed, you can enter a custom 
sms/mms gateway address, select “custom” from 
the bottom of the carrier list.
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System Settings  
 
The GC-Pro has a variety of global system settings which affect the way the controller operates and displays data. 
 

 Menus which have a lock icon are restricted to the system administrator; see Users & Passwords. 
 

Touch Panel 
 
The System menu is accessed from the main menu. 
 

 Software 
 
The system settings menus can be found in the “Controller” menu. 
 

 
 
  

System Units  
 
The GC-Pro has a variety of system units settings for temperature, speed, conductivity, dosing and more. 
Note: When changing system units, ensure that your settings are also in the correct units. 
 
Temperature: °F or °C. 
 
Wind Speed: mph or kmh 
 
Light Sensor: Set according to the type of light sensor installed. (Hi-range 5-2000W/m2, Lo-range 0.1 – 1000W/m2) 
 
EC Units: Choose between uS/cm2 and TDS (ppm.) When in TDS mode, select the conversion factor that is appropriate for 
your requirements; the three standard conversion factors are available: 0.5, 0.64 and 0.7. 
 
EC ATC: The EC has a standard automatic temperature correction (ATC) factor of 2.14%/°C which is standard for NaCl 
solutions. This value may be modified if a customized ATC factor is desired. 
 
Dosing Units: Choose between the standard volumetric mL dose unit or a time-based unit (seconds). When in volumetric 
mode, set the flow rate value to match the flow rate of the dosing pumps. 
 
Flow Rate: Flow rate (mL/Min) of dosing pumps. The controller uses this value to determine how long to operate the dosing 
pumps in order to dispense the proper amount of fluid. 

Press “System” button to access the 
system settings menu. 

The system settings menu contains  
global system settings. 
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Touch Panel 
 
Access the “System” menu from the “Main” menu. 
 

 
Software 
 
The units settings are accessed in the “Controller -> System Settings” window. 

 

 
System Timers  
 
The GC-Pro has several built-in system timers: 
 
System Start-up Delay: Delay timer that starts at power-up and disables all outputs until the time has elapsed. This can 
prevent immediate re-starting of outputs in a power glitch or allow time for sensor readings to stabilize before starting. 
 
Output Sequence Delay: Delay time that separates outputs from starting at the same time. If multiple outputs are activated 
simultaneously (such as when changing between day/night or at system start-up) the controller will separate the starting of 
the outputs by the delay time. This reduces surges in the electrical loading. 
 
Hot-Fire Delay: The outputs assigned to the lighting controls are monitored by the controller; if they turn off automatically, 
manually, or if the power is interrupted, the controller will prevent them from operating until the hot-fire delay time has 
elapsed. 
 

Press “System Units” to access the units 
menu. System password required.  

Toggle units or select a sub-menu. 
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Touch Panel 
 

 
 

Software 
 
The zone settings are located in the “Controller Settings” window. 
 

 
 
Zones  
 
The GC-Pro can monitor sensors in two different zones (two greenhouses or rooms.) To operate the system with two zones, 
place the controller into ‘dual-zone’ mode. 
 
Each control function has a setting for “Zone” number (0 defaults to zone 1.) To setup a control function to operate on the 
sensor readings and day/night status of zone 2, enter “2” for the zone number. 
 

Touch Panel 
 
 

 

Press “System Timers” to view the 
system timers menu. 

Select a system timer to modify the 
settings. 
 

Press “Zones” to change the controller 
zone mode. 

Single zone mode displays only a 
single home screen and will not show 
zone 2 controls functions. 
 

Dual zone mode will display a button 
to switch between home screens 
both zones will be displayed in the 
controls. 
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Software 
 
The zone settings are located in the “Controller Settings” window. 
 

 
 
 
System and User Passwords 
 
The controller has a system (administrator) password and four (4) operator (user) passwords. The operators have access to 
the controls functions necessary for day to day operations including temperature and timer settings, etc. The administrator 
has access to all areas of the controller including the output assignments, zone control, sensor mapping, etc. 
 
The controller logs the last 10 user login entries with time and date stamps. The administrator can retrieve and view this log 
via the PC software at any time.  
 

Setting the Passwords  
 

Touch Panel 
 
The system settings menu is accessed from the “Main” menu. 
 

 

1. From the System Settings menu press 
“Passwords” button.  
(Must be logged in as System admin.) 

2. Press the pin number button and enter the desired 1 to 4 
digit pin number. The pin number is shown in the button.  
Set to 0 to clear the password. 
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Software 
 
Navigate to “Controller -> Users -> Passwords” and select the user you wish to set or change a password for. 

 
 
Logging-In 
 
Touch Panel 
 
Once the controller has passwords setup on it, the system can be “logged out” so that it is inaccessible to un-authorized 
users. When logged out, the controller screen is locked. Only the sleep button and login buttons are usable. 
 

 

1.The controller is logged out. 
Press Log-In to access to login screen. 

2. Press the pin number button (0000) 
to enter your pin number. If a correct 
pin number is entered, the “Log In” 
button will appear; press it to log in. 
 

3. User now has access to menus and 
graphical trending. 

If System 
password set 

Enter the desired pin 
number in both 
boxes. 

When pin numbers 
match, check mark is 
shown and set button 

is enabled. 

Clear the password 
for this user. 
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Software 
 
When connecting to the controller via the PC software, you will be 
prompted to enter a password (if operator passwords are set.) 
No connection will be allowed without a matching operator or 
system password. 
 
All log-in attempts are logged by the controller including incorrect 
attempts. The controller will store the last 10 logins, the time and 
date, and whether the login was local or at the controller screen. 
 
To access the login history, navigate to “Controller -> Users -> Log-in 
History.” 

 
 
Locking the Controller from the Software 
 
If a user has left the controller logged in by accident, or if the system administrator wishes to banish a user from the 
controller, the controller can be locked-out (logged-out) remotely from the PC software. 
 
 

 
 
To banish a user: 

1. Change the user’s password (only administrator can do this.) 
2. Lock out the controller. 
3. The controller is now locked out and the user will not be able to re-gain access without a correct password. 

 
 

Controller screen will be logged out. 

Copy the history to 
the clip-board. 

Clear the history from 
the controller. 
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System Name  
 
Each controller in your facility can be named so that it can be identified from a remote connection and so that log files, 
configuration files and other information specific to each controller can be easily tracked an managed. If more than one 
controller is connected on your network, then each controller should have a unique name. 
 

Touch Panel 
 

 
Software 
 
Select “Controller -> Controller Name” from the top menu strip to change the controller’s name. 

 
 

Setting the Time & Date 
 
The GC-Pro has a precision internal clock and calendar with a built-in battery back up to maintain the clock and program 
settings in the event of a power interruption. The lighting and 24-hour based timers operate on the controller’s clock. 
 

Touch Panel 
 

 

Press “Time & Date” to change the 
controller’s time and date settings. 

Press “Adjust Clock.” 
 

Press the values to adjust with the 
numeric key pad. When the settings 
are correct, press “Start Clock” to 
set the time and date. 
 

1. From the System Settings menu press 
the “System Name” button. 

2. Press the name button to enter a 
name for the controller. 
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Software 
 
Navigate to “Controller -> Clock,” or press the clock button at the bottom of the window. 
 

 
 
Sensor Calibration  
 
The precision electronic sensors of the GC-Pro can be fully calibrated for “zero offset” and “span” (slope) if necessary. 
 
When calibrating a sensor, always perform the “Zero” calibration first. Performing a zero calibration automatically resets the 
span calibration to the factory default. Span calibrations can be performed successively without affecting the zero calibration. 
 

 
 

Touch Panel 
 

 

Zero calibration is a linear offset which shifts the 
sensor reading so that it matches the actual value. 

Span Correction 

Press “Analog Sensors” to enter the 
sensors menu. System password req’d. 

Press “Calibrate” to enter the 
calibration menu. 

Select the zone and which sensor to 
calibrate. 

Set the controller time and date 
to match the computer. 

Span calibration adjusts the slope response of the 
reading to correct for any error as the reading gets 
further away from the zero calibration point. 
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Software 
 
The calibration settings are found in each sensor’s display group. To open the calibration window, press the  button under 
the reading to calibrate. 

 
 
Temperature/Humidity Calibration 
 
Temperature and humidity both have a standard “zero offset” calibration and a “span” calibration.  
 
Note: It is advised to set the span calibration only if necessary. If it is necessary, span calibration should be done with as 
much differential from the zero calibration point as possible. 
 

Touch Panel 
 
Access the sensor calibration menu from “Main Menu -> System -> Analog Sensors -> Sensor Cal.” 
 

 
Software 
 
Press the calibration button  for the sensor to calibrate. 

 

Select a temperature or humidity sensor 
to calibrate. 

Zero: Press “Zero Offset to enter a zero 
calibration with the key pad, or press 
“+/-“ to increment by 0.1. 

Span: First enter the actual value in “Span 
Cal” with the key pad, then press “Set 
Span” to set the span calibration. Press 
“Clear Span” to restore to factory default. 
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pH Calibration 
 
pH has a standard zero calibration which is performed at pH 7, and a span calibration which can be performed at any value 
(typically pH 4 or pH 10.) 
 
 
 
 
 
 
 
Calibration Procedure: 

1. Clean and wipe the pH and temperature probes dry. 
2. Place both probes into pH 7 calibration solution. 
3. Allow the reading to stabilize and set the zero calibration. The reading should now display “7.00.” 
4. Rinse and dry the pH and temperature probes. 
5. Place both probes into pH 4 (or other) calibration solution. 
6. Allow the reading to stabilize. Enter the pH of the calibration solution and set the span calibration. 
7. Calibration is complete. The reading should display the pH of the calibration solution. 

 

Touch Panel 
 
Access the sensor calibration menu from “Main Menu -> System -> Analog Sensors -> Sensor Cal.” 
 

 
Software 
 
Press the calibration button  for the pH sensor to calibrate. 
 

 
 
Note: Always set the zero (pH 7) calibration before setting the span calibration.

Press “pH” to access the pH calibration.  Span: To set the span calibration (pH 
4/10) first, enter the calibration 
solution’s pH, then press “Set Span.” 

Automatic Temperature Correction (ATC) 
The pH reading is automatically corrected for temperature. 

The pH probe must be calibrated with the temperature probe in the calibration solution. 
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Conductivity Calibration 
 
Conductivity calibration is performed with a zero calibration with the probe clean and dry, and with a single calibration solution 
of known conductivity. 
 
 
 
 
 
 
 
Calibration Procedure: 

1. Clean and wipe the conductivity and temperature probes dry. 
2. Ensure the conductivity sensor is completely dry and wait until the EC reading has stopped falling. 
3. Once the readings are no longer falling, set the zero calibration. 
4. Place both the conductivity and temperature probes into the calibration solution. 
5. Wait for the reading to stabilize. 
6. Enter the conductivity of the calibration solution into the span calibration value and set the span calibration. 
7. The calibration is complete; the reading should display the conductivity of the calibration solution. 

 
Note: Once the zero calibration is complete, it should not be necessary again. Re-calibration of the span is all that is necessary 
to maintain the accuracy of the sensor. 
 

Touch Panel 
 
Access the sensor calibration menu from “Main Menu -> System -> Analog Sensors -> Sensor Cal.” 
 

 
Software 
 
Press the calibration button  for the conductivity sensor to calibrate. 
 

 
Note: Always set the zero calibration before setting the span calibration.

Press “EC” to access the conductivity 
calibration. 

Zero: To set the zero, press “Set Zero” 
when the probe is clean and thoroughly 
dry. 

Automatic Temperature Correction (ATC) 
The conductivity reading is automatically corrected for temperature. 

The conductivity probe must be calibrated with the temperature probe in the calibration solution. 
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Light Sensor Calibration 
 
The light sensor has a simple zero calibration which is designed to calibrate the sensor for darkness.  
 
Before calibrating the light sensor zero, ensure the light sensor is in total darkness. Allow at least 60 seconds for the light 
reading to fully settle and stabilize. 
 

Touch Panel 
 
Access the sensor calibration menu from “Main Menu -> System -> Analog Sensors -> Sensor Cal.” 
 

 
Software 
 
Press the calibration button  for the light sensor to calibrate. 
 

 
 

 
 
Software Features 
 
The GC-Pro comes with free computer software which allows full remote monitoring and control of the GC-Pro, as well as some 
additional features, including: 
 

 Data-logging to CSV files 
 Graphical trending up to 48 hours 
 Email alerts from alarms 
 Video camera monitoring and image logging 
 Upload/Download settings files to/from controllers 

 

Press “Light” to calibrate the light 
sensor. 

Zero: Press “Set Zero” to calibrate the 
light sensor zero in darkness. 
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Monitoring 
 
The sensor readings are displayed and graphed on each of the zone tabs. The graph displays up to 48 hours of history which 
can be zoomed by dragging a rectangle or rolling the scroll wheel. Use the right-click menu or buttons on the left to copy, 
print and save the graphs. 
 
Use the historical data buttons to view the max/min and average values since the last reset.

Zone 
Tabs 

Graph Legend 

Zoom Out 
Extents 

Copy to 
Clipboard 

Save 
Image 

Print 
Setup 

Print 
Preview 

Print 

Note: 
Drag a rectangle around a point of 
interest to zoom-in and get a closer 
look. Print or save a picture for 
reports. 

Clear 
Graph 

Zone 
Mode 

Hydro Sensor Display 

Start/Stop 
Monitoring 

Display Message 
Buffer History Link 

Start/Stop 
Controller 

Last message 
displayed in 

message buffer 

Controller Time/Date 
Settings Software 

communication 
display 

Connected 
controller name, 

model and 
firmware version 

Connection 
Type; serial, 

local or 
remote 

Ethernet 

Sensor Calibration Min/Max Display Climate Sensor Display 
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Data Logging Tab 
 
Data logging saves a history of your sensor readings as well as the digital input and output stats’ to a common .csv 
spreadsheet format. The program can start a new log file each day which is automatically named according to date, or all 
logging can be kept in one continuous file. A pre-view of the last 1024 lines logged is shown in the zone tabs. 
 

Zone 
Tabs 

Set the directory that the program 
should save log files to 

Select continuous or 
daily file generation 

Start / 
Stop 
logging 

Seconds between 
data samples 
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Cameras 
 
The cameras tab allows monitoring up to 8 video cameras per control system. The software can capture images from the 
cameras hourly through out the day, or at a specific time each day. Coupled with the data logs, this allows a visual log as well. 
Photos are saved with their controller name, camera number, time and date in the selected “Capture Folder.” 
 
Cameras are supplied with a set of setup instructions. When the cameras are properly configured, you can setup the cameras 
in the PC software. 
 

1. Enter the local (or remote) address of the camera. This may be an IP address or web address starting with http. 
2. Enter the user login and password information. 
3. Check the “Enable Camera” box. The software will attempt a connection. If successful, it will begin monitoring the 

camera, updating as quickly as the hardware and internet connection(s) will allow. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Currently compatible only with cameras available from Agrowtek Inc.
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Controller Settings File Upload/Download 
 
All of the settings in a GC-Pro can be downloaded and saved to an ‘.agk’ file.  
 

 Settings files can be uploaded to one or more controllers so that they all have the identical settings.  
 Settings files can be uploaded after a firmware update to quickly restore all of the settings and calibration values. 
 Download settings files and save your setup for each stage of growth. 

 

Download a Settings File from Controller 
 
1. Navigate to “File -> Controller Settings File -> Download from Controller.” 
 

 
 
 
2. Select a folder where you would like to save your settings file and enter a name for the file: 
 

 
 
3. The controller will read all of the settings in the controller; this may take a minute. When it is complete, the wait window 
will disappear and the file will be saved to the location you selected. 
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Upload a Settings File to Controller 
 
1. Navigate to “File -> Controller Settings File -> Upload from File…” 
 

 
 
 
2. Select the settings file you would like to upload to the controller: 
 

 
 
3. Select which parts of the settings file you would like uploaded to the controller. 
 

 
 

 
Controls Settings will upload all of the settings entered for the controls 
functions such as timers, thermostats, etc. 
 
System Settings will upload the sensor mapping, calibration settings, and 
other system settings such as system timers, units selections, etc. 
 
I/O Names uploads the names of the inputs and outputs stored in the 
settings file. 
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4. If the controller is running, select whether to stop it or leave it running.  
It is recommended to stop the controller before uploading a settings file. 
 

 
 
5. Verify that you want to upload the settings and you are aware that the settings in the controller will be over-written. 
 

 
 
6. The controller will write the values to the controller that you selected; this may take a minute. 
 

 
 
7. When the upload is complete, if the controller is stopped you will be asked if you want to re-start the controller. 
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Connecting to Multiple Controllers 
 
If there are multiple controllers to be monitored from one computer, they can either be connected to one at a time, or multiple 
copies of the program can be opened to monitor the controllers simultaneously. In either instance, a “Program Settings File” 
should be created for each controller to store the controller’s address, logging directories, etc. 
 
When multiple program settings files are available, the program will prompt the user to select which file they would like the 
program to open with. When opening multiple copies of the program, select the program settings file for each controller. 
 

Saving a Program Settings Files for Each Controller 
 
1. Connect to the first controller and navigate to “File -> Program Settings File -> Save As New File.” 

 
 
2. The default directory will be displayed; the file must be saved here to be loaded by the program. Enter a name for the file 
and press “Save.” 
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3. Select “Save As New File” again and save another file for your second controller (and so on.) 

 
4. Load the file that was just saved for the second controller: “File -> Program Settings File -> Load File.” Select the file and 

press . 

 
 
5. Change the data logging and camera logging directories if desired. 
 
6. Adjust the Ethernet settings as required for the second unit and connect to it. 
 
7. Ensure that the controller has a unique “Controller Name.” If there is no name set or multiple controllers share the same 
name, the data logging files may be written to the same file and the camera images may over-write each other. Files are 
named automatically with the controller name and date stamp. 
 
 

Connect to Multiple Controllers 
 
Once a configuration file has been created for each controller, the program will ask which it is to load when it opens. 
 

1. Open a copy of the program for each controller you wish to connect to. 
2. Select the program settings file for each controller. 
3. The connection settings will be automatically loaded; connect to the controller(s.) 
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Network Settings 
 

Changing the IP address 
 
The default IP address as shipped is 192.168.1.99 and assumes a router gateway address of 192.168.1.1 and subnet mask of 
255.255.255.0; these are defaults for many standard routers. 
 
To determine the settings to use, log into your router and view the configuration for your network. You may also check the 
settings that a computer on the network is using to determine the gateway and subnet mask information. 
 
 
 
 
 
 
 
 
Changing the Ethernet Settings 
 

1. To change the IP address or Ethernet settings of the controller, you must first connect to the controller via the 

standard serial port.  

2. Next, open the “Ethernet Settings” window from the “Connection” menu in the top menu strip. The current settings 

as loaded from the configuration file on the computer are shown (these may not match the settings in the controller.) 

3. Update the values from the controller to determine what the settings are in the controller; press the “Read Settings 

from Controller” button. Modify the settings as required and then press “Send to Controller.” This will send the 

settings to the controller and update the configuration file saved to the PC for future use. 

4. Cycle the power to the controller to set the new Ethernet settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE 
Each controller must have it’s own unique IP address which is not assigned to any other device on the network. 

The subnet mask and gateway must match that of the router that the controller is connected to. 

NOTE 
It is recommended to assign static IP addresses in the router so that the router  

does not automatically assign the controller’s IP to another device. 
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Port Forwarding 
 
In order to access the controller from the internet, or outide of the local area network, the network router port forwarding 
must be configured. The GC-Pro controller requires TCP port 502 to be forwarded to the IP addresses of the controllers on the 
network. 
 
The sample below shows two GC-Pro controllers on one network; “GC-Pro #1” with IP address 192.168.1.99 and “GC-Pro #2” 
with address 192.168.1.96. 
 
Both controllers have TCP port 502 forwarded to them from the router (internal port.) 
 
The “External Port” can be left as 502 as shown with “GC-Pro #1,” or can be modified to any port number desired as shown 
with “GC-Pro #2” set to external port 3000. 
 

 
 
 
 
Settings to connect to each controller: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dynamic DNS Forwarding 
 
If your internet service is provided with a static IP address, your controller can be acessed by simply entering your IP address 
into the ‘remote address’ field. If you have a dynamic IP address (like most internet connections,) you will need to use a 
dynamic dns service to generate a web address for your dynamic IP; Agrowtek recommends DynDNS.org. Follow the 
instructions on the dynamic dns provider’s website. 
 

1. Enter the URL web address from your DNS service into the ‘remote address’ field.  
For example: greengrower.dyndns.org  (“greengrower” is the dyndns user name.) 

2. Make sure the port number is correct; 502 is default. (Port forwarding must be properly setup in your router.) 
3. Press “Connect” (in the Ethernet connection box.) 

 
  

“GC-Pro #1” Ethernet Settings “GC-Pro #2” Ethernet Settings 
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Software Updates 
 
To check Agrowtek’s website for the latest software updates, navigate to “Help -> Check for Updates…” 
 
Note: An internet connection is required to check for updates. 
 
 
1. Click “Check for Updates…” The software will check the website to see if you have the latest version installed. 
 

 
 
2. If your software is out of date, you will be promted to download the latest version. Save the file to your computer.  
 

 
 
3. When the download completes, open the file and follow the prompts to install the new version.  
 
Note: It is not necessary to remove the old version first. 
 
 
4. If there are no updates, your version is up to date. 
 

 
 
 
 
 
 



© 2013 Agrowtek Inc. 
www.agrowtek.com | 83 Ambrogio Dr Suite H Gurnee, IL 60031 | agrowtek@agrowtek.com 

66 

 


